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Introduction

Corpora are simply collections of texts, though usually they are large collections of texts.
Many modern corpora, such as the 14-million-word iWeb corpus (available through
Brigham Young University’s corpus interface, which will be discussed below) are huge,
while many small, specialized corpora are around tens of thousands of words.

Corpora are not new. Many people know the word corpus from the Latin, and the name
Corpus Christi, or ‘the body of Christ’. The term comes from monastic collections of texts
on certain subjects. Those monks required a lot of reading and purposeful human searching
which can now be accomplished in a matter of seconds, using computer software called a
concordancer, or in some cases just very advanced text-editing software. While this may
make things sound easy, it might not always be. There are times when corpus results may
go against one’s expectations. However, this is not a negative; one of the bonuses of using
corpora is to avoid wholly relying upon intuition and instead draw upon authentic language
use when designing tasks.

Scraping

When using corpora for discourse analysis (or analysis of discourse) in task-based language
teaching, there are two main things we can do: gathering discourse -- often by scraping the
web -- and analysing. Scraping is a process of automatically pulling text from websites and
is one of the most convenient ways to build a corpus. If you want a written corpus this is
especially useful. Even if you want a spoken corpus, it might be difficult to get access to
real speech in the context you want to analyse discourse in (especially medical contexts),
but samples of written discourse can provide the course designer and teachers with lexis
and grammar that has a high probability of coming up.

For beginners, you can scrape the web in two ways. One with BootCaT software installed
on your computer (PC/Mac/Linux, free), another with SketchEngine, a web-based tool
(subscription, free trial available).

BootCaT

In this example we are going to scrape the web of cooking-related language.

1. Check you have the current version of Java by downloading it from. Install it. It
should take about five minutes. Download the BootCaT software from the website,
http://bootcat.dipintra.it/ , then install it.
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2. Start the software.

ﬂ BootCaT frontend

File Edit Help

The BootCaT frontend
This wizard will walk you through the creation of a corpus.

Several corpus creation modes are available, the original BootCaT creation process (that we call
"Simple” mode) involves the following steps:

& providing a list of seeds, i.e. words (or combination of words) that identify the domain
you're investigating, or generic lexical items if you want to create a general-language
corpus;

& combining these seeds in random tuples (i.e. sequences of n seeds);

@ querying a search engine to find web pages and documents that contain the generated
tuples;

& downloading the relevant web pages/documents and extracting plain text from them.

Please note that BootCaT frontend collects anonymous usage statistics, if you wish to disable this
feature, you can do so in the Options menu.

Follow the online tutorial to get started.

(on)

3. Choose a name for your corpus. | would also recommend giving it a number in case
you want to edit it or redo it afterwards.

B BootCaT frontend - O *
File Edit Help
Project definition
Corpus name  FoodMutritionCorpus_written_1
Language [English—United Kingdom !'J

More options

d

< Back Mext = Quit

© Marc Jones for Serveis Linguistics de Barcelona (SLB) SCCL, 2019



SL

Cooperativa de
Servels Linglilstics de Barcelona

4. Click Simple Mode then choose your search engine to be Google. It is not worth the

hassle of using Bing.

B BootCaT frontend = n} x
File Edit Help
‘Choose a search engine [Exlemal Browser (Google) ‘VJ
Erontend
< Back Next> Quit

Choose your seed keywords. If you have multi-word terms these should go into a line

by themselves.

& BootCaT frontend = O x
File Edit Help
Insert one seed per line, multi-word seeds go on the same line

.~ cut [} copy [ Paste

food

drink

recipe

cooking

nutrition

ingredients

sening

breakfast

lunch

dinner

snack

desserd

< Back Mext = Quit

5. Choose your tuples (combinations of seeds). How many seeds should combine and
how many tuples do you want? In this case we will just use the default settings.
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File Edit Help
The tuples that will be used as queries

Generate tuples Tuple length 3 B‘

Edit tuples M. of tuples (max 220) 10 B

Selected tuples 0

Click on ‘Generate tuples’ to proceed 6

< Back Quit
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This will then generate the list and you can disable any tuples that you don’t want but

that is pointless in most cases because BootCaT deletes duplicate data.

& BootCaTrontend

= m] x
File Edit Help
The tuples that will be used as gueries
iE] nutrition dinner serving [a
im lunch dessert dinner 1)
|[¥] cooking recipe nutrition
Frontend i@ nutrition food serving
i ] dessert snack lunch
\@ recipe lunch breakfast
i@ nutrition dessert ingredients
i@ sening recipe snack
i@ food dessert cooking
i@ dessert recipe cooking \.v
Generate tuples Tuple length 3 B
- Edit tuples - N. of tuples (max 220) FB
Selected tuples 30
Next = Quit

6. Generate the queries by clicking Open All in Browser, (unless you have an extremely
large number of queries, over about 50, otherwise Google might lock your account if
you are signed in, or block your IP address temporarily) and saving the Google
search results. If Chrome is your default browser you cannot do this from the menu
button. Right click on the page and (Save Page As) and choose HTML only. You
need to save it into your BootCaT Corpus Directory, which is at My
Documents/BootCaT Corpora/Whatever you called your corpus/queries/ .
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B BociCaTfrontend - u] X
File Edit Help

Click to open gueries in a browser

Open in Browser | snack cooking recipe l;
Open in Browser snack serving breakfast

Open in Browser | snack ingredients cooking

Open in Browser | dessert recipe cooking

Open in Browser recipe lunch breakfast

Open in Browser | ingredients recipe dessert

Qpen in Browser drink dessert nutrition

Open in Browser | cooking recipe nutrition

Qpen in Browser dinner nutrition breakfast

Open in Browser lunch dessert dinner
Qoenin Browser | lunch food nutrition b
Open All in Browser { Open Queries Folder J l Collect URLs J

Open queries in a browser, save result pages to 'queries’ folder and then click on ‘Collect 6

< Back Mext = Quit

B BootCaT frontend - o X

File Edit Help

Hide advanced options £}

Limit search to the following Internet domain (e.g. .edu).

Exclude these Internet domains (e.g. .com, wikipedia.org, books.google.*);
www.google.* F

‘www.googleadservices.®

Restrict search to this document type: v
Exclude these document types: . Reset

Excluded document types:

Adult filter (filter sexually explicit material) MODERATE | ¥

Maximum number of URLS to return for each tuple 10 E

! Generate Queries

Click on ‘Generate Queries’ to generate search engine queries

< Back Next>

7. Make the corpus by waiting for BootCaT to pull the websites and clean them.

B BootCaT frontend — ] X

File Edit Help

Show advanced options L)

ntpime o l§
Parsing file
i 452y healthy-diet
Parsing fils
i tingwell
Parsing file
http:/iwww. eatingwell 77
Parsing file
itp: v eatingwell i 4-day-ol ting-meal-plan-1200-cal
Parsing file 4
i singwell 1
Parsing file
hittp: i eatingwell
Parsing file
hitp:tiwww. zatingwell ight loss-diet
Passing file
http: singwell. 5
Parsing file .
<X - - - — - s
I— L \
Build corpus Open corpus folder
Building corpus, please wait e

<Back

8. You are now ready to choose your concordancer to do the analysis: see the Corpus
Analysis section below.
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An alternative to BootCaT, which can be temperamental after Java updates, is

SketchEngine. Although this requires a paid subscription (after an initial free trial), it’s a
powerful tool.

SketchEngine

1. Go to http://app.sketchengine.eu/ and register for a free trial.

2. You can build your own corpus or upload one. First we’ll show you how to use
SketchEngine in the same way as we’ve just demonstrated with BootCaT, i.e. by
scraping the web to build a corpus.

3. Log in to SketchEngine, select the My Corpora tag and click New Corpus on the
right.

@ (@ M

NEW CORPUS

Words

13,382 e

5,903 e

4. Give your corpus a title, select the language and click next.

CREATE CORPUS @ = @ |

1. CREATE CORPUS

Name FoodNutritionCorpui

Language  English

MULTILINGUAL

Description

5. Select Find texts on the web. SketchEngine gives you the option of choosing
search words or websites. It is advisable to choose words for a wider variety of
discourse. Choose your seed keywords. Separate them by commas. If you have
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multi-word terms these should be spaced as normal with a comma after the

multi-word terms themselves.

Input type @ Web search
O URLs
QO Website

food X nutrition X recpe X  cooking X

ingredients
Folder name web1

Web search settings ~
Black list settings ~
White list settings ~

Size restrictions >

< Compile when finished

CANCEL

6. You can choose how big the files should be. It is probably best not to fiddle with
these numbers. SketchEngine works well with PDF files so big files should be
included. Remember that a webpage is usually only a matter of kilobytes so the small

size is useful. SketchEngine will tell you when it is finished.

Compiled

RECOMPILE CORPUS DASHBOARD

Expert settings ~ Log ~

GET TO KNOW YOUR CORPUS!

8= EXTRACT KEYWORDS & TERMS @ CORPUS DETAILS AND STATISTICS

BACK
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Compiling your own corpus

In this instance we will look only at SketchEngine, which is by far the easiest as it accepts a
wide range of document formats and does all the tagging automatically.

The advantage of compiling your own corpus over scraping is that by collecting examples
of specific target discourse. e.g. medical abstracts or transcriptions of Scrum demo
dialogues, we can analyse language as it is used to complete the target task, rather than
the wider language of the domain.

1. Collect your examples of target discourse e.g. in .txt, .doc or .pdf format and place
them in a folder on your computer. They could be examples of texts written for a
specific purpose, or transcriptions of spoken English that you have typed up
yourself or used YouTube to create. See the Session 3 Extension for more
information on how to do this.

2. Follow the above steps on using SketchEngine to scrape a corpus, until Step 5. This
time, however, select: | have my own texts.

3. Select and drag files from the folder your created into the upload box.

UPLOAD FILES or paste text

Choose a file or drag it here.

Q Will my data stay private?

4. Wait until your texts have been processed. You can add more texts or folders in the
meantime.
5. Click Compile and shortly your corpus should be ready to analyse.

Compiled

ADD MORE TEXTS RECOMPILE CORPUS DASHBOARD

Expert settings  ~ Log ~

GET TO KNOW YOUR CORPUS!

8= EXTRACT KEYWORDS & TERMS @ CORPUS DETAILS AND STATISTICS
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Corpus Analysis

The main way language teachers have their first encounter with corpus linguistics is through
dictionaries or vocabulary lists in coursebooks. While dictionaries and word lists both have
their uses, most coursebooks contain very little in the way of real-life tasks. One way that
we can bring authentic language into authentic situations for our learners is by analysing
corpora. In this section, we’ll use SketchEngine first, then some free software called
AntConc made by Laurence Anthony, an academic in Japan who also teaches English for
Specific Purposes. Finally, we’ll take a quick look at the Brigham Young University corpus
interface (BYU Online corpora).

Some output we are likely to want from the corpora we are investigating:

Concordances - samples of your corpus, with your search term in the middle. Your
concordancer usually shows between 10-20 lines of examples. You won’t usually
get full sentences but you can click to get the full context. The concordance
functions are extremely similar in SketchEngine, BYU Online Corpus and AntConc.
You can search for single words, phrases and you can also search for parts of
words using wild card functions like * and ?. The wildcard functions let you leave a
gap so you can search for grammatical patterns in AntConc. Additionally, if you have
programming experience, you can also search using Regex, which can save you
time, but is not essential for our purposes.

Word list - the words in the corpus ordered by frequency;

Keyword list - the words in the corpus that occur at a statistically higher frequency
than those in a reference corpus. This is often referred to as ‘keyness’ which is
positive for higher frequency words, and negative for words that appear statistically
more frequently in the reference corpus.

N-Grams - these are essentially chunks of language ordered by frequency. It’s
usually a good idea to check the frequency of N-Grams against high frequency
words because some of your N-Grams are likely to be more high frequency than
your key words. The name comes from the length being N words long, or the user
chooses how long they are. Mostly you’ll choose up to five words long.

Collocates - these are words that appear within a certain distance of your search
term. The default settings in most tools are 5L 5R, which simply means within five
words to the left and five words to the right.

Clusters - these are lists of words that are frequently to the left or to the right of
your search term.

© Marc Jones for Serveis Linguistics de Barcelona (SLB) SCCL, 2019

11



S LB Cooperativa de
Servels Linglistics de Barcelona

SketchEngine

In the sections above, you made a corpus either by scraping the web or uploading your own
folder of texts. You're ready to analyse that corpus now. It's a good idea to generate your
word list first (the most frequently occuring words in your corpus). This will give you an idea
of how frequent your search terms are (in the case of a scraped corpus) and if any other
specific terms are high in the list. It might mean going back a stage and remaking your
corpus (and possibly deleting the one you just made due to lack of storage space).

WORD LIST FoodNutritionCorpus

BASIC ADVANCEL

(2]

find words all

lemmas starting with

©
8

nouns ending with

verbs containing

adjectives

adverbs

Your keyword list is also incredibly useful. It is a list of the most probable words to occur in
your corpus as compared to a reference corpus. The reference corpus is just another
corpus, usually much larger, that you compare your own corpus to. The default reference
corpus in SketchEngine is their own EnTenTen15 web corpus (which is around a billion
words in size). You can change this to other corpora such as BNC15 (British National
Corpus, 2015) and COCA (Corpus of Contemporary American English). For specialised
corpora, such as healthcare, it gives you an idea of how much jargon you might expect in
typical written communication, and therefore how much of this would need to be known for
spoken communication.

Alongside the keyword list, the new version of SketchEngine will also generate a list of key
N-Grams or terms. There’s more on this below. It's worth noting that all lists on
SketchEngine can be downloaded in PDF, CSV, XLS and XML formats.

© Marc Jones for Serveis Linguistics de Barcelona (SLB) SCCL, 2019
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KEYWORDS
BASIC ADVANCED
Keywords and terms help us

Keywords

in the reference corpus.

individual words (tokens) which appear
more frequently in the focus corpus than

FoodNutritionCorpus

understand what the topic of the corpus is or how it differs

from the reference corpus. By default, general language corpora are used as reference
corpora to represent non-specialized language.

Terms

multi-word expressions which appear
more frequently in the focus corpus than
in the reference corpus and, additionally,
match the typical format of terminology
in the language.
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You can also generate a separate N-Gram list. If you choose your N-Gram to be 3 or 4
words long (the default) you get three-to-four word chunks ranked by frequency in the
corpus. You can also specify the minimum range (how many texts each N-Gram should
appear in). Don’t be afraid to fiddle with these settings until you get something you can work
with. It's really useful for finding idioms and discourse markers, and especially for pragmatic

functions like hedging.

N-GRAMS

BASIC ADVANC

N-gram length 2

O Include nonwords

O aA=a

FoodNutritionCorpus

ED

Waord
3 4 5 6

idon't

do n'tknow
ido n'tknow

you need to

you know you
you do n't

that would be
the people who

one of the

n'tknow if

+ Count

52 e

36 e

32 e

Word

mhm you know

ithink i

have to take

great baoks or

do n't know if

and then you

all of the

you want to

got a four

but i do

+ Count

Most frequent N-Grams in spoken academic advice sessions: from R. C. Simpson, S. L.
Briggs, J. Ovens, and J. M. Swales. (1999) The Michigan Corpus of Academic Spoken

English. Ann Arbor, MI: The Regents of the University of Michigan
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Finally, the Word Sketch function is the major advantage of SketchEngine. You can type in
a lemma (root form of a word. e.g. ‘ride’ is a lemma, ‘rides’, ‘riding’ and ‘rider’ are not
lemmas). It will give you a comprehensive display of how the word collocates with different
words and different parts of speech. It's a good idea to run the Word Sketch on at least the
top 20 or so keywords. This should give you an idea of any obvious ‘marked’ (somewhat
unusual) language use, such as nominal modification (nouns used to modify nouns as
opposed to adjectival modification), which is often a feature of technical/scientific language.

WORD SKETCH FoodNutritionCorpus @ (o) ®@ [ ! ]
: .
diet as noun 57x Q *+ ® _:::_ O *
S B Qg X S RO X e 2O X e Bg X & O X e #goX
- . neouns medified b verbs with "diet" as verbs with "diet" as _ repositional
modifiers of "diet" e 14 3 L "diet" and/or ... pree
'diet’ object subject phrases
paleo plan revamp consist moment ... on "diet"
the Paleo diet diet plans revamp your diet The raw food diet consists moment , the raw food
diet ... of "diet"
low-carb shake adopt live
fun to "diet"
Low-Carb Diet diet shake adopting a plant-rich diet Diet Live
fun and balanced diet
mediterranean requirement tell fit ... iN;: "diet™
low-carb
The Mediterranean Diet diets , nutritional told the Paleo diet diet fits B
requirements \dqwtfoarb, high-protein ... than "diet"
balanced hil h process follow i
iloso| —
balanced diet P S processed diet diet follows whole-food - from "diet
My food and diet
e philosophy build do Ev;l;g\e—foods, plant-based "diet" for ...
The raw food diet consists food diet is built Diets do
. need ... for "diet"
: Diet Anti-inflammatory
special follow be diet and specific nutritional
Wit i
special diets follow a gluten-free diet Paleo diet is R diet” with ...
food base contain requirement ... about "diet"
The raw food diet consists diet is based diet contains diets ;nutriional Back to the original interface

This is another way to analyse corpora you have compiled yourself, and is free. However, it

involves more work on your part.

1.

Go to Laurence Anthony’s webpage http://www.laurenceanthony.net/software.html .
Download AntConc if you haven’t already. You might also download TagAnt and the
tag list, too. You should also download some useful word lists, such as the BNC

British English word list and BNC American English word list in AntConc format from
Paul Baker’s website:
https://www.lancaster.ac.uk/linguistics/about-us/people/paul-baker . You’ll need to

scroll down quite far. It's probably more useful to have these word lists on your

desktop than in your downloads folder so move them before you start.

If you are using a corpus you made in BootCaT, it is not tagged yet. If you are using a
corpus that you know is tagged, skip to step 3.

Open TagAnt. Your corpus you made is in a directory that is usually at My
Documents/BootCaT Corpora/Name of your corpus project/ so go to File > Open
Directory and choose the directory your corpus is in. Load and start. It shouldn’t take
much longer than a couple of minutes.

© Marc Jones for Serveis Linguistics de Barcelona (SLB) SCCL, 2019
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e TEE T R T - i
@- 7 .
e |
x b Input Text Clear | Results % l
o |7 TNER il
i
il
2017/08/18%:15 () InputFiles: 0 ad ear
|
\
|
|
>
@ Horizontal () Vertical Clear
JAS-0ER Fouul
Language English ~ Start Stop.

3. AntConc runs as an executable file which means you can run it from a USB flash
drive or your computer. Open the file and tell your computer that you really do want to

run the file

Go to File > Open Directory and choose the directory your corpus is in.

5. Next, open Global Settings. We'll start with tags hidden. Click Apply after you change

this setting

E ¥

File Global Settings
Corpus Files
000_tagged.txt
001_tagged.txt
002_tagged.txt
003_tagged.txt
004_tagged.txt
005_tagged.txt
006_tagged.txt
|007_tagged.txt
008 _tagged.txt
009_tagged.txt
010_tagged.txt
011_tagged.txt
012_tagged.txt
013_tagged.txt
014 tagged.txt
|015_tagged.txt
016_tagged.txt
017_tagged.txt
018_tagged.ixt
019_tagged.txt
020_tagged.txt
021_tagged.txt
022_tagged.txt
|023_tagged.txt
024_tagged.txt

Total No.
109
Files Processed

‘- Global Settings

Tool Preference:

Concordal

‘Concordan
Hit

Category

[Character Enceding
[Colors

[Files

Tag Settings
O Show tags @ Hide!ag;; (O Hide tags (Search in Conc/Plot/File View)
Hide non-embedded tags

|Fonts

[Token Definition
(Wildcards

Search Ter|
L
Start

Kwic Sort

Level 1

[ < | starttag |

Hide embedded tags

Hide header tags

St
Endiag

| Endtag

Apply

Cancel
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file by clicking File > Save Output As.

| @ AntConc 34.4w (Windows) 2014 - o X
Taking § File | Global Settings Tool Preferences Help
Open Filels)... Ctrl+F  pusFiles MU e Plot File View Cli Collocates Word List Keyword List
Open Dir... Ctrl+D —:"’9992 m Word Types: 7522 Word Tokens: 98797 Search Hits: 0
{tagge
Close Selected File(s) fiagged Rank  Freq  Word Lemma Word Form(s) A
Close All Files | tagged.bxt 1 3233 |and
[ tagged.txt 2861 |the
Clear Tool iccest
Clear All Tools [tagged bt 3 2509 |of
Clear All Tools and Files Ltagged.nd 4 2473 |to
| tagged bt
Sove Output o Tet .. Cul=S 20000 5 2303 )
Import Settings from File... | tagged.txt 6 1449 |in
Export Settings To File... tagged.bdt 7 1243 |you
- [tagged.ot X
Restore Default Settings | tagged.bat 8 1215 |is
Bt | tagged.bxt 9 1183 |for
tagged.ot 5
016_tagged.ixt 10 946 it
& P 017_tagged.txt 11 945  [that
ress the &
3 | P 12 (927 |are
take a screel tagge
1020 tagged.tt 13 883 |or
briefly. 021_tagged.txt 14 /42 lvonr
Your scree 022.12gged bt i
023 tagged.xt Search Term [ Words [ Case [] Regex Hit Location
imost ccaggedt S [ || Advanced | [search Only
» Ifyour st roiing Start stop Sort Lemma List
Ctrifr B W F’,?ip Sortby [] Invert Order
iles Processed
Sort by Freq ~ Clone Results

SLB

Cooperativa de
Servels Linglistics de Barcelona

6. Go to Word List. Click start. You have your word list and you can export it as a text

7. To generate your keywords list you need to load a word list or a reference corpus
(see part 1 of this section), then click apply. You probably don’t have a whole
reference corpus but you have word lists. Go to Tool Preferences, choose your word
list, load it and then click Apply.

@ Tool Preferences

Category

Keyword List Preferences

[Concordance Display Optio ates Word List Keyword List
(Clusters/N-Grams Rank Frequency Keyness Keyword o
(Collocates i Formis A
Word List Other Options pre
Keyword List Treat all data as lowercase
[ Treat case in sort
Keyness Values
Keyword Generation Method |Leg-Likelihcod -
Threshold Value All Values -
[ Show negative keywords (using highlight color)
Reference Corpus
©) Use raw files) @) Use
d Load
Total No. 0
Add Directory| | Add Files | |Swap with Target Files| | Clear Lis
v
Apply Cancel
Clone Regylt;

© Marc Jones for Serveis Linguistics de Barcelona (SLB) SCCL, 2019

16



SLB

W Tool Preferences. —

Category Keyword List Preferences

[Concerdance Display Options

(Clusters/N-Grams Rank Frequency Keyness Keyword
(Collocates

Word List Other Options

Treat all data as lowercase

[ Treat case in sort

Keyness Values

Keyword Generation Method [Log-Likelihood -

Threshold Value

L] Show negative keywords (using highlight color)

Reference Corpus
QO Us e(s) @ Use word list(s)
:
TotalNo. 1
AMEOBANtconc.tit
Add Directory { Add Files | |Swapwith Target Files| | Clear List

Apply

Cancel

lates' Word List Keyword List
L]

-ation

List || Loaded

Clone Results

brd Form(s) "

8. Generate your keyword list. Save your output again.

W AntConc 3.4.4w (Windows) 2014 - [m] *®
File Global Settings Tool Preferences  Help

ape e Concordance Concordance Plot File View Clusters/N-Grams Collocates Word List Keyword List

000 tagged.tet Types Before Cut: 7522 Types After Cut: 5206 Search Hits: 0

001.tagged.uxt Rank  Freq  Keyness Keyword ~
1002_tagged.txt

003_tagged.txt 1 510 |2376.567 |diet

004 tagged.tet 2 481 2138398  [foods

1005_tagged.txt =

006_tagged.na 3 440  1803.111 protein

|007_tagged.txt 4 401 1698.082 [fat

1008_tagged.txt

005 tagged.txt 5 843 1589.944 'your

010_tagged.txt 6 345 1551352 imeal

[011.tagged.txt 7 497 1528918  |food

1012 _tagged.txt %

013 tagged.ot s 399 1484886  |weight

|014_tagged. txt 9 319 1466371 calories

1015_tagged.txt

016 tagged.tet 10 348 1392.268 :eat

017 _tagged.txt 11 330 1363078 |healthy

018 tagged.ut 12 245 1093524 (fiber

019 _tagged.txt

020 tagged.tet 13 359 1052.907 g

|021_tagged.txt 14 517 1005577 mutrition

1022_tagged.txt v
023 _tagged.txt Search Term [/] Words [ Case [ Regex Hit Location

1024 _tagged.txt

<] | Advanced
Toklle L Stop ot Reference Corpus
;I?:s e Sortby [ Invert Order
6 5ot oy Keyriess e

Search Only

Loaded

Clone Results

Cooperativa de
Servels Linglistics de Barcelona

If you are using a corpus which is just one text file (and some corpora are set up like
this) set the minimum range (number of text files in the corpus) to 1 in the following

steps, otherwise you will have no output.

9. You can also generate N-Grams and clusters. N-Grams are easiest. Choose the
minimum and maximum size of N-Gram and minimum range you want each one to
occur in. Again, do not be afraid to fiddle with things here. When you are ready you

can save your output again.
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@ AntConc 3.4.4w (Windows) 2014 - m] ®
File Global Settings Tool Preferences  Help

aipis e Concordance Concordance Plot File View Clusters/N-Grams Collocates Word List Keyword List
000 tagged.tut Total No. of N-Gram Types 19568 Total No. of N-Gram Tokens 81269
001_tagged.ixt R
ank Freq Range  M-gram ~
002_tagged.ixt
003_tagged.txt 1 253 71 of the
004 tagged.td 2 248 |60 |nt
005_tagged.txt | E
006_tagged.tt 3 240 |68 lin the
007_tagged.txt 4 213 |53 lits
008_tagged.ixt .
009 tagged bt 5 210 |59 if you
010_tagged.xt 6 188 |34 weight loss
011 tagged.tut 7 173 |54 lisa
012_tagged.ixt
8 145 |55 on the

013_tagged.bxt

014 tagged.txt 9 143 |44 to eat
015_tagged.ixt |
016 tagged ot 10 137 |14 meal replacement
017_tagged.txt 11 136 |47 |such as
018 tagged.td 12 134 51 lyoucan
019_tagged.txt e
020_tagged.tt 13 130 (30 high in
021_tagged.txt ¥
022_tagged.fxt Search Term Words Case Regex N-Grams N-Gram Size
023 tagged.txt Advanced | Min.|2 5 Max.
024_tagged.txt el == oy El
" sep Sort Min. Freq. Min. Range
Total No. Sortby []InvertOrder  Search Term Position
L — [sotbyFrea  v] ilonteft onRight
LA Sort by Freq On Left On Right
E— Clon e

10. Clusters are groups of words with your chosen word at either the left of the cluster or
the right. Check the cluster box, set your size and range (quite low is usually better).
Type a word then press Start. You can save these to text files in exactly the same
way. The same applies regarding minimum range here.

W@ AntConc 3.4.4w (Windows) 2014 — O x
File Globkal Settings Tool Preferences  Help
Forpus Files Concordance Concordance Plot File View Clusters/N-Grams Collocates Word List Keyword List
000 _tagged .ot Total No. of Cluster Types 1380 Total No. of Cluster Tokens 2023
|001_tagged.bxt R
ank Freq Range  Cluster ~
002_tagged.oa nk  Fr N S——
|003_tagged. txt 1 64 31 your diet
(004 _tagged.txt 2 33 18 |healthy diet
005_tagged.txt i
006_tagged.bet 3 29 17 a healthy diet
007_tagged.txt 4 23 |6 of diet
|008_tagged.txt B
009 tagged.tet 5 21 18 a diet .
|010_tagged.oxt 6 19 12 balanced diet
[011_tagged.txt 7 19 14 in your diet
1012_tagged.txt | )
|013_tagged.txt 8 17 12 to your diet

014 _tagged.bet 9 16 1 healing diet
015_tagged.ixt

(016_tagged.txt 10 14 3 food diet
|017_tagged.txt 11 14 12 the diet
018 Ingged bt 12 13 | loss diet
|019_tagged.txt g
|020_tagged.txt 13 13 |2 raw food diet
|021_tagged.bdt hd
022_tagged.txt Search Term Words [ ] Case [] Regex [ ] N-Grams Cluster Size
023 tagged.txt [diet | Advanced | Min[2 Emax[S =]
1024 _tagged.txt v | F
! z | Stop Sort Min. Freq. Min. Range
Total No. Sortby [ lnvertOrder  Search Term Position
L — '
v ]
Files Proc Sort by Freq [] On Left On Right
— =

11. Collocates in AntConc generates words that appear within different proximities to
your search term. The default search is 5L,5R, or five words to the left and to the
right of your search term. You get to see if the collocating words occur to the right,
the left and their frequencies. You can also save this as a text file.
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W AntConc 3.4.4w (Windows) 2014 —
File Global Settings Tool Preferences Help
Crpurs Files Concordance Concordance Plot File View Clusters/N-Grams Collocates Word List Keyword List
000_tagged.tet Total No. of Collocate Types: 1222 Total No. of Collocate Tokens: 5066
001_tagged.txt Rank Freg Freq(L) Freg(R) Stat Collocate
002_tagged.txt ? =
003_tagged.txdt 1 255 191 64 442288 a
004 tagged.tet 2 157 88 |69  [3.62040 to
005_tagged.txt
006_tagged.txt 3 155 |93 62 339165 the
007_tagged. bt 4 133 |81 52 3.36021 |of
008_tagged.tat
009_tagged.txt 5 114 |48 6b 2.77206 |and
010 tagged.tet 6 95 79 16 444829  your
011 tagged ot 7 95 24 71 392094 s
012_tagged.txt
012_tagged.txt 8 87 6 81 7.29930 soda
014_tagged. bt 9 86 47 39 3.52325 in
015_tagged.txt
016_tagged.td 10 74 64 10 4.62240 |on
017_tagged.tet 11 I3 21 52 3.50804 you
18 tigged by 12 64 30 [24 338959 for
019_tagged.txt
|020_tagged.tat 13 50 20 30 335751 |that
021_tagged.tdt 14 5N a2 a laa753R  |healthy
022_tagged.txt
023_tagged.bxt Search Term Words [] Case [] Regex Window Span [ ] Same
24 tagged.d LN | Advanced | From..[FL_ oK =
Total No. Start Stop Sort Min. Collocate Frequency
108 75
1 >
e pr—— Sortby [ Invert Order
]

Clone Results

Cooperativa de
Servels Linglistics de Barcelona

12. To search for grammar patterns, you can go to Global Settings and choose show
tags. Cluster, collocates and concordance tools are the most useful for syntax (word
order and pattern) investigations. You might want to see if a given noun is more
usually preceded by adjectives or nouns. You can click to see examples of these.
Tree Tagger tags (the tags used in TagAnt) for simple adjectives are *_jj’ and for
singular nouns ‘_nn’. To search for [infinite verb + noun] patterns, search “# vvp # n*”.
# and * are wildcard characters. # means ‘any one word’ and * means ‘one or more
characters’. This means we search for [‘any one word’ ‘vvp’ ‘any one word’ ‘any noun
tag’] because all noun tags start with n and are two or three characters long. It may
be useful to search this in the cluster tool on the left as well as the concordance tool.

A AntConc 2.4.4w (Windows) 2014 —
File Global Settings Tool Preferences Help

|015_tagged.ixt
016_tagged.txt
017_tagged.ixt
1018_tagged.txt
|019_tagged.txt
020_tagged.txt
021_tagged.txt
022_tagged.txt
|023_tagged.txt
024 _tagged.bxt

Total No.
109
Files Processed

Corpus Files Concordance Concordance Plot File View Clusters/N-Grams Collocates Word List Keyword List
000_tagged.txt Total No. of Cluster Types 9 Total No. of Cluster Tokens 20
001_tagged.ixt R

ank Freq Range  Cluster
|002_tagged.fxt § S g 5
|003_tagged.txt il 4 4 contain_vvp caffeine_nn
004 _tagged.txt 2 2 2 contain_vvp caffeine_nn _sent
005_tagged.ixt g
006_tagged.tt 3 2 2 contain_vvp lots_nns
|007_tagged.xt 4 2 2 contain_vvp lots_nns of
008_tagged.txt e .
009 tagged.txt 5 2 |2 contain_vvp lots_nns of_in
|010_tagged.ixt 6 2 2 contain_vvp sugar_nn
011 tagged.txt 7 2 2 linclude_vvp soy_nn
012_tagged.ixt s
013_tagged.tat 8 2 12 offer_vvp protein_nn
014_tagged.txt 9 2 12 provide_vvp nutrients_nns

Search Term Words [ Case [] Regex [ N-Grams Cluster Size
[#wp#ne | Advanced | min[d Emax[T 2]
- Stop Sort Min. Freq. Min. Range

Sortby [ Invert Order Search Term Position

Sort by Freq ~ OnLeft [ OnRight

Clone Results
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BYU Online Corpora

There are several different corpora available at https://corpus.byu.edu/. These are handy for
more general applications, as well as for getting used to how corpora work. If you need to
analyse ‘general’ written English, the iWeb or GloWBe corpora may be useful. If you have
certain localities in mind, like the US, COCA could be useful and for Canada, there is the
Strathy corpus. The Corpus of American Soap Operas could also be handy for generalised
spoken language.

corpus.byu.edu

home corpora wusers related resources my account upgrade help

Created by Mark Davies, BYU (Google Scholar). Overview, search types, looking at variation, corpus-based resources.

The most widely used online corpora — more than 130,000 distinct researchers, teachers, and students each month.

English # words language/dialect time period compare

iWeb: The Intelligent Web-based Corpus m 14 billion US/CA/UK/IE/AU/NZ 2017 Info (¥3X)

News on the Web (NOW) 1.5 billion+ 20 countries / Web 2010-last month

Global Web-Based English (GlowbE) 1.9 billion 20 countries / Web 201213

wikipedia Corpus 1.9 billion English 2014 Info

Hansard Corpus 1.6 billion British (parliament) 1803-2005 info

Early English Books Online 755 million . British 1470s-1690s .

Corpus of Contemporary American English (COCA) . 560 million . American 1990-2017 b

Corpus of Historical American English (COHA) 400 million American 1810-2009 M,

Corpus of US Supreme Court Opinions . 130 million . American (law) 1790s-present

TIME Magazine Corpus 100 million American 1923-2006

Corpus of American Soap Operas 100 million American 2001-2012 »

British National Corpus (BYU-BNC)* 100 million British 1980s5-1993 E
L Strathv Corpuc (Canada) Somillion Canadian 1970::2000<

iYou can search for words and collocates, much like in SketchEngine or AntConc above.
Unfortunately, there is no N-Gram search in the BYU Online corpus interface. You may want
to look at the KWIC concordances.

iWeb: The 14 Billion Word Web Corpus @, @ @
SEARCH FREQUENCY OVERVIEW
7

FIND SAMPLE: 100 200 500 1000
PAGE: << < 1/468 > >>

CLICK FOR MORE CONTEXT O =1 SHOW DUPLICATES

1 scrum.org A B €| Scrum Product Owner Il Prove Your Advanced Knowledge of Product Ownership # The Professional Scrum Product OwnerG level Il (PSPO 1) assessment is available t
2 |scrum.arg A B|C| thePSPO | assessment and wishes to demanstrate his or her bility o apply the Scrum framework to salving complex problems regarding praduct ownership- in the
3 |scrumeorg A|B|C| recognized PSPO Il Cerification as an indication of their advanced knowledge and abillties pertaining to Serum and the role of the Scrum Product Owner. # Anyane a
% | scrumore; A|B| | indication of their advanced knowledge and abilities pertaining to Scrum and the role of the Scrum Product Owner. # Anyone attempting the PSPO Il should have in
5 SCrUM.Org A B C| ofthe Scrum Product Owner. # Anyone attempting the PSPQ Il should have in-depth Scrum and Product Owner experience and have taken the- Professional Scrum F
6 scrum.org A B C| PSPO Il should have in-depth Scrum and Product Owner experience and have taken the- Professional Scrum Product Owner course- prior to taking this assessment. |
7 |scrum.org A|B| €| - Prepare for the Assessment # The PSPO- assessments are- grounded in the- Professional Scrum Product Owner- subject areas. The assessment is exhaustive and ri
8 |scrum.org A|B|C| rigorous. Many questions ask you- to think about or interpret the meaning from the- Serum Guide, - apply content fram the PSPO- subject areas, and in some cases
PR — A|B| €| additional information to help you prepare for the PSPO- Assessment and ways to learn about Scrum. - Certification # If you pass the PSPO Il assessment you will rec
10 | secrum.org A B € .Inaddition, your name wil be listed on Scrum.org. - # Unlike other Scrum certifications that require anly class attendance, Serum.org certification requires & minimu
11 |scrum.arg A B|C| ,and they are very quickly losing respect for the PO. # As a Scrum Masrer, I'm struggling to rein him in. I've mentioned their tendency

12 |scrum.org A|B | C| 'Technical Product Owner' which might be a role that can be incorporated in SCRUM alongside the Business Product Owner. Having technical AND business knowled
13 |sensmne A|B| €| then itstime to find out what his agenda really is... # In Scrum PO ought to do a mental trade-off: less predictable, but release quality outcomes

94, [Seimoe A|B] €| not.complex it riight be complicated, though), therefore benefits coming fram EETHR implémentation are kimited (is PO able to forrmilate a Speint GoalZl-

15 | scrum.org A B €| their job properly. # Try focusing more on the actual structure and rigor of Serum Events, For example: - a Scrum Master should ensure that anly the Development

You can, however, gain an excellent overview on the main page of the iWeb corpus with
some main clusters and collocates.
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iWeb: The 14 Billion Word Web Corpus @, (%)

SEARCH CONTEXT OVERVIEW

COLLOCATES Advanced options ﬁ Collocates | Clusters Topics Dictionary Websites KwiC 6 &

daily

184 | 4.81 dominant

1448 | 250 | | product front
1021 | 3.04 development

923 [3.82| | owner

facilitate

155 | 4.74 lean sprint 12| 6.10 offside

140 | 6.80 | | attacking
134 | 2.91 extreme
122 | 2.64 Irish

110 | 421 resulting

91 8.56 uncontested
7.27 | | iterative

dominate 271 | | superbly

923 | 589 | | framework 252 | purposefully

889 |7.18 methodology
877 | 4.10 meeting
848 | 3.24 role

259 optimally

3.04 | | comprehensively

3.05 | | deceptively

770 | 616 [l alliance 2.58 | | interchangeably

5
4
4
4
4
.}
3| 268 | hotly
3
3
3
o
2
2

I 1 | | coach
87 | 3.02 practice
68 | 3.12 master

768 | 550 | | penalty
758 | 476 [l half
666 | 3.67 || guide
656 |2.73 | | media

72 | 6.03 | | ensuing

72 | 897 kanban

71 2.69 defensive
69 | 578 @ halfway

59 |5.64 | | retrospective

272 inexplicably

4.15 uncharacteristically

61 | 454 concede 6.47 diversely

267 | | ruthlessly

547 | 7.01 sprint 56 | 2.65 | | reset

539 |3.80 coach 58 | 4.81 ‘empirical 50 | 2.69 collaborate

35 | 4.50 l ensue

2.86 | | tactically
3.00 | | headfirst

mmm@mmmmmmmmm@m!!

mmm@mmmmmmmmmmm!{
S

@wmwm@l!!f

402 | 2.97 | | ball 53 |430] | Welsh

iWeb: The 14 Billion Word Web Corpus

SEARCH OVERVIEW

Collocates Clusters Topics Dictionary Websites KWIC & HELP

scrum. oun © 9 e TOPICS (more)
1. {rugby football) the method of beginning play in which the agile, team, try, penalty, ball, sprint, half, score, project, rugby, software, development, backlog,
forwards of each team crouch side by side with locked arms defence, match, kick, developer, kick, minute, master
& @ rlayphrase YouGlish Yarn COLLOCATES (more)
e Translate: choose language NOUN team, master, project, product, development, framework, owner, methodology

VERB implement, adopt, scale, facilitate, sprint, dominate, collapse, award
SYNONYMS (more) AD] agile, certified, daily, dominant, lean, attacking, extreme, irish

struggle, fray, scrimmage, free-for-all, tussle, scrum, ADV  half, forwards, backwards, front. offside, superbly. purposefully, optimally

jostle

NOUN + NOUN (more)

scrum NOUN SCrum master s SCcrum team « scrum teams » scrum alliance « scrum masters « scrum half «

NOUN scrum media scrum «
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Analysing corpora for TBLT

Before you start analysing the corpus, you need to bear in mind the task for which you are
searching for related discourse. In this example, let’s take the corpus we made using
BootCaT and think of a task related to English for nutrition students, Give general advice
regarding diet.

First it would be useful to select some words to search in the collocates and clusters tools in
AntConc or in SketchEngine. These words can be based upon our own intuitions regarding
the keywords, e.g. diet, eat, healthy, you* (equals you/your). Among other items were:

for a healthy plans fewer

of a healthy keeps smaller
(help) maintain a (may/can/to) help you foodists
healthy good for you choosing
as part of a healthy boost your regularly

healthy diet
healthy eating

healthy fats

increase your
you lose weight

your metabolism

what you eat
foods to eat

foods you eat

healthy weight

your diet that people who eat
heart your body feel free to eat
choices you can the foods you eat
living you to eat fewer calories
maintaining you should eat plenty of

We then can look at the words and patterns that are found with our search terms. We then
have more to look at and can search our corpus concordances for these and they will give
use some ideas of written discourse which we shall have to evaluate as to whether it is
appropriate for spoken output in our prototypical task.

What comes back to add to the above is:

Eat plenty of fruits and vegetables

Eat plenty of fruit, vegetables and wholegrains
Eat plenty of soy and bean products

As part of a healthy diet

Help you maintain

Maintain a healthy weight
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Maintain muscle

The (comparative adjective) food you eat, the (comparative

adjective)

To boost your metabolism

Foods in your diet

People eat fewer calories (preposition)
You can also/easily/get

We now have a large amount of authentic language to help create a prototype task featuring
these main patterns. The task could look something like the below, although bear in mind we
would need to take other factors into consideration apart from the key vocabulary and
collocations, i.e. the modality of the task (spoken or written), the audience, and the typical
structure (e.g. turns, moves etc.). See the Session 6 presentation for more on this.

Prototype Task: Give general advice regarding diet.

As part of a healthy diet, you should eat less fewer salty foods and drink less caffeine. The
more salt and caffeine you consume, the faster your heart beats and in our current
environment, a lot of people have racing hearts. It’s also important to eat plenty of fruit,
vegetables and wholegrains to maintain energy throughout the day while also reducing the
amount of heavier carbohydrates you eat, such as bread, rice, pasta and potatoes. The
more vegetables you eat, the more that these count toward your carbohydrate intake. This
will help you lose weight if necessary, while also maintaining enough calories to fuel you for
the day. You shouldn’t cut out fats and heavy carbohydrates completely: feel free to eat
these in moderation. The important point is to reduce the foods that are unhealthy when
eaten too much and to increase foods that will boost your metabolism and maintain your
health.
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